AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for FCS I-Services with Avaya
Communication Manager and Avaya 4626 and 9640 IP
Telephones- Issue 1.0

Abstract

These Application Notes describe the procedures for configuring FCS I-Services to
interoperate with Avaya Communication Manager and the Avaya 4626 and 9640 IP
Telephones. FCS I-Services is an IP telephone application designed for use in a
Hotel/Hospitality environment, with features such as Auto Wake-Up, Do Not Disturb
activation, Web Services, Text Messaging, Email, and retrieval of Hotel information.

Information in these Application Notes has been obtained through DeveloperConnection
compliance testing and additional technical discussions. Testing was conducted via the
DeveloperConnection Program at the Avaya Solution and Interoperability Test Lab.

DAH; Reviewed: Solution & Interoperability Test Lab Application Notes lof21
SPOC 8/25/2007 ©2007 Avaya Inc. All Rights Reserved. CM-FCSIS



1. Introduction

These Application Notes describe the procedures for configuring FCS I-Services to interoperate
with Avaya Communication Manager. FCS I-Services is an IP telephone application designed
for use in a Hotel/Hospitality environment, with features such as Auto Wake-Up (AWU), Do Not
Disturb (DND) activation, Web Services, Text Messaging, Email, and retrieval of Hotel
information. It works in conjunction with FCS WinSuite! (a Windows-based Hospitality system
that provides a real-time multitasking interface between a PBX and a hotel’s Property
Management System (PMS)), FCS Connect’ (a sophisticated small-scale in-house call center
solution that enables hoteliers to implement “on-touch” service request capabilities from all guest
telephones) and FCS VoiceMail® (a Windows-based Voice Messaging system designed
specifically for Hospitality environments) to provide a variety of screen-based capabilities to
guest telephones.

The configuration used in performing compliance testing of FCS I-Services is shown in Figure
1. It shows a network consisting primarily of a pair of Avaya S8720 Servers running Avaya
Communication Manager in a High Reliability configuration with two Avaya G650 Media
Gateways, an FCS I-Services server, and Avaya 4626* and 9640 IP Telephones (representing
guest telephones). A Windows-based DHCP server is accessed by the Avaya 4626 and 9640 IP
Telephones to acquire an IP address and locate and download the appropriate firmware and
settings files to register successfully with Avaya Communication Manager. Interfacing with this
environment is a wireless telephony network including the following: an Avaya Voice Priority
Processor; a Wireless Access Point; Avaya 3600-Series Wireless IP Telephones (specifically the
3616, 3641 and 3645), representing devices used by hotel staff, or “runners”; an FCS Connect
server; and a SpectraLink Netlink OAI Gateway, through which FCS Connect sends wireless text
messages to, and receives wireless updates from, the runners’ phones. (FCS Connect also
connects to ports on one of the Avaya G650 Media Gateways via analog ports on an Intel
Dialogic card to enable guests to submit service requests via an IVR module, but this interface
was not used in the compliance testing of FCS I-Services.) In addition, FCS WinSuite accepts
requests from the guest telephones via FCS I-Services to enable features such as DND
(forwarded by FCS WinSuite via a PMS data link interface to Avaya Communication Manager),
AWU (sent to FCS VoiceMail via TCP/IP), Housekeeping/Room Status/Minibar updates, etc.

These Application Notes assume that all FCS products used in Figure 1 have been installed and
configured by FCS services personnel, and that their respective integrations with Avaya products
have been completed. For details on the integration of FCS WinSuite, FCS Connect and FCS
VoiceMail with Avaya products, please refer to [2], [3], and [4].

! Configuration details for this product can be found in [2].
2 Configuration details for this product can be found in [3].
® Configuration details for this product can be found in [4].
* This telephone was designed and developed specifically for Hospitality environments.
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Figure 1. Sample Test Configuration

2. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment Hardware/Firmware/Software
Version
Avaya S8720 Server Avaya Communication Manager

4.0.1 (R014x.00.1.731.2)
Avaya G650 Media Gateway | 26.31.0

e TN799DP C-LAN HWO01 FW156

e TN2312AP IPSI HW15 FW039

e TN2302AP MedPro HWO02 FW142

e TN2224CP 2-Wire HWO08 FW015

Digital HWO02 FW019
e TN464HP DS1 000019
e TN746B Analog Line
Avaya 4626 IP Telephone 2.4
Avaya 9640 IP Telephone S15
DAH; Reviewed: Solution & Interoperability Test Lab Application Notes 3of21
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Equipment

Hardware/Firmware/Software
Version

Avaya 3616 Wireless IP
Telephone

110.064 069.048 106.013

Avaya 3641 Wireless IP
Telephone

119.024 117.013 118.018

Avaya 3645 Wireless IP
Telephone

119.024 117.013 118.018

Avaya Voice Priority
Processor (SVPP Type: 100)

33/02

Factory Page: 230.007
Downloader: 230.157
Table of Contents: 173.027
Functional Code: 174.027
File System: 175.027

SpectraLink Netlink OAl
Gateway

06/81

Boot Code: 001.010 (0d7a)
Factory Page: 085.001 (02fd)
Flash1l Downloader: 031.007
(0233)

Functional Code: 082.017 (014f)
fnctla.bin 082.017 (014f)

FCS I-Services Server

4.01 (with Windows 2003 Server
SP 2)

FCS Connect Server

3.0.0 (with Windows 2003 Server
SP 2)

FCS WinSuite Server

3.0.8 (with Windows 2003 Server
SP 2)

FCS VoiceMail Server

4.0.0 (with Windows 2003 Server
SP 2)

DAH; Reviewed:
SPOC 8/25/2007

Solution & Interoperability Test Lab Application Notes

©2007 Avaya Inc. All Rights Reserved.

40f 21
CM-FCSIS



3. Configure DHCP Server for Avaya 4626 and 9640 IP

Telephones

The Avaya 4626 and 9640 IP Telephones must load specific parameters in order to access I-
Services successfully. This section details the steps required to configure the DHCP server to
direct the Avaya 4626 and 9640 IP Telephones to the necessary settings file.

Step Description

1. Set Scope Options for Avaya 4626 IP Telephone:

Open the DHCP administrative client (Start -> Programs -> Administrative Tools ->
DHCP). In the left pane, select the Scope Options icon under the DHCP Server used by
the Avaya 4626 and 9640 IP Telephones. In the table that appears on the right, double-click
on the 176 Avaya Options entry: In the Scope Options window that is presented (see
below), select the General tab and add HTTPSRVR=a.b.c.d (where a.b.c.d is the IP
address of the HTTP server to be used) to the string in the String value field. Click OK.

Scope Dptions [ 7| I

General | Advanced I

Awailable Options | Dezcriphion :I
[ 074 Intemet Relay Chat [IRC) Servers Ligt of IRC =

[ 075 StreetT alk Servers Lizt of Stree

[ 076 StreetT alk. Directory Assistance [STDA) Servers  List of STD.-C_I
176 Avaya Options Auapa Optic -
| | _>I_I

— Drata entry
String value:

[ TFTPSRVR=3.1.1.11 HTTPSRVR=3.1.1.11.5]

OF I Cancel Apply
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Step

Description

2. Set Scope Options for Avaya 9640 IP Telephone:

General | Advanced |

Available Options | Dezcription ﬂ
[0 075 StreetT alk. Servers Ligt of Stree

[ 076 SkreetT alk. Directary Assistance [STDA) Servers  List of STDE
176 Avapa Options Auwaya I:I|:|ti|:_l
242 tyvapa 96=x Options =
<| | of”

—Data entry
String walue:

|1.'I.B,|‘-1EF'EIHT='I FIGHTTPSRYR=9.1.1.115M

(] 8 I Cancel Apply

Returning to the Scope Options table (see Step 1), double-click on the 242 Avaya 96xx
Options entry: In the Scope Options window that is presented (see below), select the

General tab and add HTTPSRVR=a.b.c.d (where a.b.c.d is the IP address of the HTTP
server to be used) to the string in the String value field. Click OK.

Scope Options EE3 I
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Step

Description

The picture below shows the modified Scope Options in the DHCP administrative client.

19 pHep IH[=] E3
File Action Yiew Help
AEEIENCIE
@ DHCP Scope Options
E‘"@ gov-dhep-tftp. gov.com [3.1.1. 141 T oorion Name | ‘Wendor | Walue | Class
=@ °F'9 R [Tl ﬁum Router Standard  9.1.1.1 Mone
@ 233’855 fm' 008 DNS Servers Standard 91,110 Mone
CE o resst eases g@ms DS Domain Marme Standard  Gov.com Mone
- eservations
gﬁé 176 Avava Options Standard MCIPADD=9.1,1.8,MCPORT=1719, TFTFSRYR=5.1.1.11,HTTPSR¥R=9,1,1.11,5IFPROXY... Mone

@ Scope Options
(L Server Options

g@242 Avaya 96 Options  Standard  MCIPADD=9.1.1.8,MCPORT=1719,HTTPSRYR=9.1.1.11,5MMPSTRING=public, SMMPADD...  Mone

4. Configure Downloadable Web Parameters for Avaya 4626
and 9640 IP Telephones

This section describes the steps needed to add the parameters and settings related to FCS I-
Services functionality to the set of parameters downloaded from HTTP server to the Avaya 4626
and 9640 IP Telephones in order to enable FCS I-Services to interoperate with these telephones.
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Step

Description

Add FCS I-Services parameters for Avaya 4626 IP Telephone to 46xxsettings.txt file:

Edit the 46xxsettings.txt file on the HTTP server that is used by the Avaya 4626 IP
Telephone (in C:/FTP_ROQOT) and advance to the section of the file where the Web settings
are defined for the Avaya 4626 IP Telephone (see below). Define the following variable
values using the SET command.

Note: In the items listed below <I-SVCS IP> should be replaced with the IP address of the
FCS I-Services Server (in this example, 9.1.1.175).

e WMLIDLEURI: This is the location of promotional Web pages to be retrieved
& displayed after WMLIDLETIME (minutes) is reached; set to
http://<I-SVCS IP>:8080/IPTNET/AVAY A/Adver.aspx.

e TPSLIST: This is the Trusted Push Server (TPS) location; set to <I-SVCS IP>.

o SUBSCRIBELIST: At startup, the IP telephone navigates to this address to
provide ID information (i.e. IP address, phone type, MAC address) to FCS I-
Services; set to
http://<I-SVCS IP>:8080/IPTNET/AVAY A/getPhonelnfo.aspx.

e WMLHOME: This is the main home page to be displayed on the IP telephone;
set to http://<I-SVCS IP>:8080/IPTNET/AVAY A/Main.aspx.

e WMLIDLETIME: Set to the desired number of minutes of idle time before the
promotional Web pages (located at WMLIDLEURI) are retrieved and displayed
(in this example, 5).

Click File -> Save to preserve the changes.

HHHAHHHBHHH AT
# SETTINGS4626
HHHAHHHBHHH AT

#HHHH##HHE Web Settings for 4626 1P Phone ###HHHHH
#SET APPNAME a26d0la2_716.bin

#SET APPNAME a26d01a2484.bin

#SET APPNAME 4626emulator.bin

SET WMLIDLEURI http://9.1.1.175:8080/1PTNET/AVAYA/Adver .aspx

SET TPSLIST 9.1.1.175

SET SUBSCRIBELIST http://9.1.1.175:8080/1PTNET/Avaya/getPhonelnfo.aspx
SET WMLHOME http://9.1.1.175:8080/1PTNET/AVAYA/Main.aspx

SET WMLIDLETIME 5

#SET PROCPSWD 1111111

SET PROCPSWD 31

goto END
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Step

Description

Add FCS I-Services parameters for Avaya 9640 IP Telephone to 46xxsettings.txt file:

Edit the 46xxsettings.txt file that is used by the Avaya 4626 IP Telephone (in
C:/HTTP_ROOT) and locate the section of the file with the comment heading

## Per Model Settings

Add a line below this heading, similar to those in this section of the file, that reads as
follows:

IF $MODEL4 SEQ 9640 goto SETTINGS9640

Advance to the section of the file where the Web settings are defined for the Avaya 9640 IP
Telephone, or create a section if necessary (see below). Define the same variables with the
same values as entered for the Avaya 4626 IP Telephone in Step 1. Click File -> Save to
preserve the changes.

HHHHHHBHHH AT
# SETTINGS9640
HHHAHHHBHHH AT

#HHH###HE Web Settings for 9640 1P Phone ####H#HHH
#SET APPNAME a26d0la2_716.bin
#SET APPNAME a26d01a2484.bin
#SET APPNAME 4626emulator.bin

SET WMLIDLEURI http://9.1.1.175:8080/1PTNET/AVAYA/Adver .aspx

SET TPSLIST 9.1.1.175

SET SUBSCRIBELIST http://9.1.1.175:8080/1PTNET/Avaya/getPhonelnfo.aspx
SET WMLHOME http://9.1.1.175:8080/1PTNET/AVAYA/Main.aspx

SET WMLIDLETIME 5

goto END

Once FCS I-Services has been properly configured (see Section 5), reboot the Avaya IP
Telephones to download the added parameters to each telephone.
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5. Configure FCS I-Services

This section details the steps to be taken to configure FCS I-Services to interoperate with Avaya
Communication Manager and the Avaya 4626 and 9640 IP Telephones. These Application
Notes assume that the FCS I-Services application has already been properly installed by FCS
services personnel. Note: Since many of the administrable aspects of FCS I-Services exercise
the same functionality of the Avaya 4626 and 9640 IP Telephones (i.e.
display/navigation/population of Web-based menus and forms), administration of only a subset
of such features is explained here. For details on the full set of features, consult the appropriate
FCS I-Services documentation or go to http://www.fcscs.com.

Step

Description

1.

From a Web browser, navigate to the FCS I-Services System Configuration utility. At the
login screen, provide the appropriate credentials and click Login. The default screen is
presented, as shown below.

FEC S | computer Bystems

i FCS IPT Services v.01 & l ¥ System Configuration

Configuration a3
User Configuration
System Information
Menu Configuration
IP Phone Interface Translation

2 Help Menu
€ Logout

Room Information "4
Communication Services
Info Services (3
Web Services U‘J/

£a

Instant Services **
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http://www.fcscs.com/

Step Description
2. Add User IDs for hotel staff (e.g. maids, supervisors, etc.):
From the Configuration menu, select User Configuration. Click the Add button to the
upper right to add a user. The User Configuration entry form is presented, as shown
below.
Populate the fields as follows:
e ID: This can be left blank (FCS I-Services will assign this automatically).
e User Name: Enter a descriptive name (in this example, housekeeping).
e Language: Select a language from the drop-down menu. This will
determine the format of content to be pushed to the IP telephones.
e Password: Enter a string to be used as a password.
e URL.: Enter a Web location to be associated with this user. (Although this
field is mandatory, it can be as simple as http:// (as used in this example).)
e Access Level: Select a level of permission for this user (Admin, Supervisor,
User or Guest).
Click Save to add the new user.
FES | computer oymmoms 20 July 200
i FCSTPT Services vA.01 L l # User Configuration
—
Configuration
ST = [
Menu Canfiguration Language: [Please select a language] B v F— 222
IP Phone Interface Translation
- Help Menu it /7 ) Supervisor v
0 Logaut URL: Access Level:
DAH; Reviewed: Solution & Interoperability Test Lab Application Notes 11of21
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Step Description

3. Enable guests to view bills and text messages at their IP telephones:

FCS I-Services.
Click Save to submit the changes.

From the Configuration menu, click System Configuration. In the form that is presented
(see below), select the check boxes next to Support Folio Request (i.e. to allow guests to

view their bills) and Support Text Request (to allow guests to view text messages). Note:
The text fields in this form are for informational purposes only, and are not used directly by

20 July 2007
FCS | computer systems
i FCS IPT Services v401 e l ¥ System Information
= I
Configuration -~
User Configuration e i | Hotel Name: |
System Information
Menu Configuration Operatar Mo, 1550 | Phone No: |
IP Phone Interface Translation
O Help Menu FO No: 1530 | Faut No: |
© Logout Housekeeping No: 1590 | S No: |
Cercierge Ho 1520 ‘ (5005 |
Erginesr Ne: 1520 ‘ (1520 |
NightShift Mo s003 | [rctokye |
R [ |1 suppon Folio Request |
Adeess: | suppar Tea Request |
[~] |1 upport Courty Code |
Version: ikl |
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Step

Description

4. Add/modify menu items presented to guest telephones:

From the Configuration menu, select Menu Configuration. A table containing details
associated with the various default menus and submenus presented to guest telephones is
displayed, as shown below.

FCS | computer Systems

€S IPT Services v4.01 7

Configuration
User Configuration
System Information
Menu Configuration
IP Phone Interface Translation
L Help Menu
0 Logout

AN
Room Information A7

Communication Services

Info Services (j

l # System Configuration

—
GroupMame
=] Configuration
ModeID ModeName Url Srouphlame Icon
0.03 User Configuration cfglserList.aspx Configuration | iconléficonlé_06.qif
0.04 Systemn Information cfgSysInfo.aspx Configuration | iconléficonlé_06.qif
0.05 Menu Configuration cfgMenuConfig.aspx Configuration | iconléficonlé_06.qif
0.06 IP Phone Interface Translation cfgTranslateConfig.aspx Configuration | iconlé/ficonlé_06.gif
0.07 Help Menu cfgPhoneGuidelist.aspx | Configuration | iconléficonlé_20.gif
0.10 Logout cfglogout.aspx Configuration | iconléficonlé_26.qif
=] Room Information
ModeID Modelame url Grouphlame Icon
0.11 Room Information cfgRoomList.aspx Room Information iconlé/ficonlé_54.gif
0.1z Welcome Page Setting cfgWelcomePagelist.aspx Room Information| iconléficonl6_54.qif
0.13 Promotion Schedule | cfgPromotionList.aspx Room Information iconlé/ficonlé_54.gif
0.14 Request Information | cfgRequestlist.aspx Room Information iconlé/ficonlé_54.gif
=] Communication Services
ModeID ModeName Url GroupName Icon
1.2 IDD Assistant & Call Rate cfgIDDAssistantlist.aspx Communication Services iconlé/iconlé_36.gif
1.3 Can Messages cfgiCanMsglist.aspx Communication Services| iconléficonl6_36.qif
=] Info Services
ModelID NodeMame Url SroupMame Icon
30,11 Country General info ofgCountryFactList.aspx Info Services iconlédiconlé_01.gif
30,12 Hotel General info cfgHotelFactList.aspx Info Services iconlédiconlé_01.gif
30,13 Maps cfgMapList.aspx Info Services iconlédiconlé_01.gif
30,14 Hotel Event & Functions | cfgHotelEventlist.aspx | Info Services iconlédiconlé_01.gif
30,15 Country Local Attractions cfgAttractionList.aspx | Info Services iconlédiconlé_01.gif
3016 Consulates & Embassies  cfgEmbassisList,aspx Info Services iconiédiconié_01.qif
=1 Web Services
ModelID ModeMame url GroupMame Icon
40,10 Stock Exchange | cfgStockList.aspx ‘Web Services jconlé/ficonif_68.gif
40,11 Weather Forecast cfgWeatherCityList,aspx Web Services jconlé/ficonif_68.gif
40,12 Timezone cfgTimezonelist.aspx ‘Web Services jconlé/ficonif_68.gif
-1 Tnctant Sarvicac
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Step Description

5. To modify an existing menu item, click next to the associated table entry. The Menu
Configuration — Edit screen for that menu item is presented, as shown below. (To add a
new menu item, click Add to the upper right.)

The fields are defined as follows:

e ID: Thisis assigned by FCS I-Services when the item is created.

e Group Name: This is the name of the menu group in which this item is to be
displayed.

e Node ID: This defines the order in which menu items are displayed in the
associated group (e.g. X.1 comes before x.2).

e URL Page: This is the Web page that is displayed when this menu item is
selected.

e Node Name: This is the displayed name of this menu item.

e lcon (20x20).gif: This is the location of the .gif file containing the image that is
to be displayed next to this menu item.

Buttons are available to Delete the item, Copy the contents to a new item (which can then
be modified), Save any changes, or Cancel any changes.

20 July
FCS | computer Systems
: FCSIPT Services v4.01 e l # Menu Configuration - Edit
—
User Canfiguration B Fioom Information
System Information Iz e BEp Rk
Menu Configuration A 012 URL Page: cigiweloomePageList asps
IP Phone Interface Translation
= Help Menu Node Name. ‘Welcome Page Setting Jeon [20420) g icon Giconl6_54.gif
€3 Logout
DAH; Reviewed: Solution & Interoperability Test Lab Application Notes 14 of 21
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Step

Description

6. Define display characteristics of guest telephones (e.g. buttons title texts, menus, messages,

etc.):

From the Configuration menu, select IP Phone Interface Translation. A table of IP
telephone display items is presented, as shown below>

FCS | computer systems

IPT Sexvices v4.01

|

T
Configuration “-*

20 July 2007 4:03:59 P.M.

l ¥ Translation

(09) L 46 5 |

=

User Configuration

System Information

Menu Configuration

IP Phane Interface Translation
= Help Menu
O Logout

Room Information /J-\
Communication Services
Info Services O

Web Services N‘JJ

- ]

Tie |

| Find

Title

Main Menu

XS EtDND

txESetAWLI

DHDORF

AwUNew

ALEdit
Cormmunication Services
Info Services

Instant Services

Select Language

Help Menu

IDD Assistant

SMs

Phone Call Tariff

Group Member List

Bills And Messages
mnuSMsRoomToRoom
mnuSMsInbox
muSMSsent
tetMewMessage

Country General Info
Hotel General Info

Maps

Express Services

Hotel Restaurant Reservation
Hotel Spa Reservation
Ernail

Hotel Functions And Events

Local Attractions

Draq & calurnn header hers to group by that calumn

Type English

NN I NN IO

Main Menu
Set DoNotDisturh

Set Autowakellp

DD is Off

set Wake Up Calls

List Wake Up Calls
Communication Services
Info Services

Hotel Services

Language Selection

Help Menu

10D Assistant

SMS

Fhone Call Tariff

Group Member List

Bills And Messages

SMS Room To Room

SMS Inbox

SMS Sent Items

Hew message

Country General Info
Hotel General Infa

Maps

Express Services

Hotel Restaurant Reservation
Hotel Spa Reservation
Email

Hotel Functions And Events

Local Attractions

Record Rangs

Cantonese French

Menu Principal

Germnan =

Hauptmenii

Services De Communication Kormmunikation O

Services D'Information
Services Instantanés

Choisissez La Langus

Menu D'Aide

Info Dienstleistu
Sofortige Dienstle
wahlen Sie Sprac
Hilfernenti

slalale
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Step Description
7. To modify an existing display item, click next to the associated table entry. The
Translation Detail screen for that display item is presented, as shown below. (To add a
new menu item, click Add to the upper right.)
The fields are defined as follows:

e Menu Title: This identifies the display item in the table.

e Type: This is one of four values from the drop-down: (1) — Title, (2) — Menu,
(3) — Button, (4) — Message.

e English, Japanese, French, etc.: These fields define the language-specific text
that will be displayed for this item, depending on the language associated with
the given guest telephone.

Buttons are available to Save any changes, Delete the item, or Cancel any changes.
ch Computer Systems
i FCSIPT Services vi.01 - I} Translation Detail
[ TV
Configuration "

User Canfiguration . /N e [

System Infarmation Hen Tite ‘

Menu Configuration Type: 1-Title v

IP Phone Interface Translation Translation:

2 Help Menu Endlish: Set wake Up Calls [a]

e Logout ? ‘
Japanese: O00000000000000

=i

=]

French ‘

_ [a]

German: ‘

<]

Cantonese ‘

. =]

b4 andarir: ‘

Italian: ‘l

’ Save ] [ Delete ] l Cancel ]
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Step

Description

Administering the IDD Assistant:

The IDD Assistant automatically prefixes an IDD (International Direct Dial) call with the
country code and city code associated with the specific city selected, as well as informing

the user of the rate to be charged for such a call.

From the Communication Services menu, select IDD Assistant & Call Rate. The IDD
Assistant table is presented (the view shown below is after selecting North America from

the set of regions listed above the table).

FCS | computer Systeams

i FCS IPT Services v:.01 l # IDD Assistant

Configuration gt
N Language: English [eng]
LAl

Room Information

.
Communication Services L=

= Drag a column header here to group by that column
IDD Assistant & Call Rate

= Lang Seq ReagionMarne  CountryMarne

Can Messages gi==alpeed i

eng | 170| Morth America Canada
eng | 171| Morth America Canada
eng | 172| Morth America Canada
eng | 173| Morth America Canada
eng 174 Morth America Canada
eng 175 Morth America Canada
eng 176 Morth America Canada
eng | 177| Morth America Canada
eng | 178| Morth America Canada

CountryCode CityName

N

1

eng | 179| Morth America United States of america 1
eng | 180| Morth America United States of america 1
eng | 181| Morth America United States of America 1
eng 182 Morth America United States of America 1
eng 183 Morth America United States of America 1
eng 184 Morth America United States of America 1
eng | 185| Morth America United States of America 1
eng | 186| Morth America United States of America 1
eng | 187| Morth America United States of america 1

[Africa] [Asia] [China] [Europe] [Pacif

Montreal (Metropolitan) 514

Montreal (Quter) 450
Ottawa 613
Quebec 418
Toronto (Metropolitan) 418
Toronto (Outer) ans
Vancouver (Metropalitan) | 604
Vancouver {Outer) 250
Windsor 519
Atlanta 404
Boston {Massachusetts) |617
Chicago 31z
Haw aii a08
Los Angeles 213
Mew York City (Mew vork) 212
San Francisco 415
Wlashington DC 202
Philadelphia 215

CityCode Rate

16 / 6 seconds
16 / 6 seconds
16 / 6 seconds
16 / 6 seconds
16 / 6 seconds
16 / 6 seconds
16 / 6 seconds
16 / & seconds
16/ 6 seconds
4/ 6 seconds
4/ 6 seconds
4/ 6 seconds
4/ 6 seconds
4/ 6 seconds
4/ 6 seconds
4 /6 seconds
4 /6 seconds
5/ 6 seconds
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Step

Description

To add a city, click Add. The IDD Assistant entry form is presented, as shown below. Fill
in the form as follows:

ID: This is assigned automatically by FCS I-Services.

Region: Select from the drop-down menu the region where this city is located (in

this example, North America).

Language: Select from the drop-down menu the language spoken in this city (in

this example, English).

Sequence No. Enter the place in the list of cities in this region where this entry
will fall; if left blank, it will default to O (i.e. at the top of the list).

Rate: Enter a ratio of cost over time (in this example, 6 / 6 seconds).

Country: Enter the country where this city is located (in this case, United States

of America).
City: Enter the name of the city (in this case, Denver).

Country Code: Enter the country code to be dialed (in this case, 1).
City Code: Enter the city code or area code of this city (in this case, 303).

Click Save to add this new city.

* IDD Assistant

ID: [

Fiegion Maorth America v Language: | Englizh [eng]
Sequence No: 188 Rate: £ ¢ B seconds

Country: Urited States of America City: Derver

Country Code: 1

City Cade: 303

Save

] [ Cancel

6. Interoperability Compliance Testing

Interoperability compliance testing focused on FCS I-Services’ ability to work with Avaya
Communication Manager and the Avaya 4626 and 9640 IP Telephones. FCS I-Services features
and capabilities that were verified included the following: general display of Web-based content,
creation/delivery/receipt of text messages and emails, outbound dialing using IDD Assistant,
creation/activation of speed dial entries via the Web interface, viewing of charges on guest bills,
receipt of Housekeeping/Room Status changes initiated at guest telephones and forwarding to a
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simulated Property Management System, setting of AWU calls, and DND
activation/deactivation.

6.1. General Test Approach

Feature functionality testing was performed manually using the Avaya 4626 and 9640 IP
Telephones (i.e. the guest telephones) to navigate the Web-based menus, activate features, and
place local and PSTN calls. A simulated PMS application (co-resident with the FCS WinSuite
server) was used to provide account information for guest bills. The other FCS products in the
configuration provided complementary functionality as described in Section 1.

6.2. Test Results
All executed test cases were completed successfully.

7. Verification Steps
This section describes steps that may be used to verify the configuration.

Step Description

1. From the customer’s Property Management System, check in one of the Avaya IP
Telephones as a guest telephone. Verify that the default Welcome Page is pushed to the

be used to transition to different menus.

telephone’s screen by FCS I-Services, and that the navigational buttons on the telephone can

2. Select the DND button (i.e. a physical button labeled “DND” by FCS I-Services) and follow

the menu prompts to activate DND. Place a call from another local extension and verify
that the guest telephone does not ring, and that the call is redirected to the guest’s voice
mailbox.

3. From the Main Menu, select Communication Services -> IDD Assistant. Select, in turn, a

region, country, and city, then key in only the local telephone number for the selected IDD
call and select Submit, then select Dial. Verify that the call is launched to the appropriate
destination using the correct prefix information.

4, To send a pre-defined text message to another guest telephone, select Communication
enter the destination room number (see [4] for a correlation between room number and

delivered to the destination guest telephone, and that the recipient is prompted with an
audible alert as well as a shortcut to view the message directly.
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Services -> SMS & Emails -> SMS -> SMS Room to Room. Select one of the messages,

telephone extension), complete the message, and select Submit. Verify that the message is




8. Support

For technical support on FCS I-Services, contact FCS Computer Systems at
http://www.fcscs.com/support.htm.

9. Conclusion

These Application Notes describe the procedures for configuring FCS I-Services to interoperate
with Avaya Communication Manager and Avaya 4626 and 9640 IP Telephones. All
interoperability compliance test cases executed against such a configuration were completed
successfully.

10.

N

4.

Additional References

“Administration for Network Connectivity for Avaya Communication Manager,”
Document ID 555-233-504.

“Application Notes for FCS WinSuite with Avaya Communication Manager.”
“Application Notes for FCS Connect with Avaya Communication Manager and Avaya
3600-Series Wireless IP Telephones.”

“Application Notes for FCS Voicemail with Avaya Communication Manager.”

Additional product documentation may be found at the following sites:

e Avaya: http://support.avaya.com
FCS: http://www.fcscs.com
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DeveloperConnection Program at devconnect@avaya.com.
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